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Introduction to MapInfo ProViewer



Welcome! Congratulations on your choice of MapInfo ProViewer, the easy way to see, print, and share electronic desktop maps. This convenient map viewer opens MapInfo tables created using MapInfo products such as MapInfo Professional, MapX, or MapXtreme and displays them in Map and Browser windows. It also opens MapInfo workspaces and recreates Map, Browser, Graph, and Layout windows exactly as they were created in MapInfo Professional. Using this product you can display and print maps and workspaces created in any version of the MapInfo product line. The purpose of this chapter is to familiarize you with the basics of MapInfo ProViewer and provide resources for you to become familiar with it. You can also get installation assistance from MapInfo Technical Support, if necessary, using information in this document. Š Š Š Š Š Š Š Š Š



Installing MapInfo ProViewer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4 What’s New in MapInfo ProViewer 9.0? . . . . . . . . . . . . . . . . . . . . . .4 Displaying a Map in MapInfo ProViewer . . . . . . . . . . . . . . . . . . . .12 Understanding the ProViewer Toolbar . . . . . . . . . . . . . . . . . . . . . .13 A Brief Tour of the World.wor Workspace . . . . . . . . . . . . . . . . . . .14 Getting Online Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .17 Getting Technical Support. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .17 Want to do MORE? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18 Understanding ProViewer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .21



What’s New in MapInfo ProViewer 9.0?



Installing MapInfo ProViewer To install MapInfo ProViewer: 1. Click the Start button and click Run and type or browse to the ProViewer setup.exe file. Click the OK button to begin the installation. The Welcome screen displays. 2. Click Next to continue to the License Agreement dialog box. 3. Click I accept the Terms and click Next to display the Customer Information dialog box. Complete these fields with appropriate entries to continue. 4. Click Next to display the Destination Folder dialog box. 5. In this dialog box, click Next to accept the default path or click Change to select a new path. The Ready to Install dialog box displays. 6. Click Install to begin the file transfer. The Installing dialog box displays. 7. You are prompted to display the readme document. Click OK to view the readme; click Cancel to end. The InstallShield Wizard Completed dialog box displays. 8. Click Finish to complete the installation of MapInfo ProViewer.



What’s New in MapInfo ProViewer 9.0? This section contains information about the new features of ProViewer 9.0. Please note that due to the extensive additions to the MapInfo maps and layout features, .TAB files and .WOR files created in MapInfo Professional 9.0 cannot be displayed using the ProViewer 8.5 product. These are the new features you may see in your 9.0 maps: •



Curved Labels Improve the Look of Your Maps



•



New Data Sources May Display in Version 9.0 Maps



•



Time and Date Time Data may Display in Version 9.0 Maps



•



Using the Find Command in Remote Tables



•



Multiple HotLink Capability Added



•



Homeland Security Fonts Added



•



New Projections and Coordinate System Supported



Curved Labels Improve the Look of Your Maps We added curved labels as a new feature in MapInfo Professional 9.0. Curved labels are labels that follow the curve of streets, rivers and other linear map features as shown in the next figure. Maps created with curved labels can be displayed in ProViewer and older maps can be modified in MapInfo Professional 9.0 to display this new functionality. However, older maps do not display this feature automatically and you cannot use ProViewer to display curved labels if the map has not been created using this feature. If you open a map with curved labels in an older version of ProViewer, you will get an error.
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MapInfo ProViewer 9.0



Chapter 1: Introduction to MapInfo ProViewer



Here there are curved labels on the Streets, Railroads, and WaterRivers layers.



New Data Sources May Display in Version 9.0 Maps In MapInfo Professional version 9.0 MapInfo has partnered with a third-party vendor named Safe Software and incorporated some of their Feature Manipulation Engine (FME) technology. This gives MapInfo Professional 9.0 users more flexibility in creating maps using the following data sources: • • • • • • •



ESRI ArcSDE ESRI Personal Geodatabase (*.MDB) AutoCAD.DWG/DXF Microstation Design (*.DGN) ESRI ArcInfo Export (*.E00) USGS Spatial Data Transfer Standard (*.CATD.DDF) VPF NIMA/NGA (*.FT)



If your map creators have used these data sources to create your map, and you have the FME product, layers with this data display in ProViewer. You cannot open these datasets by themselves directly using ProViewer. Note: If you try to open some new .tab files or workspaces that contain some of the extended formats that are available with the full FME product, you may get an unlicensed formatrelated error if you do not have the full FME product yourself. If you own the full FME product, you can extend ProViewer to display these files. To display more universal data source formats in MapInfo ProViewer: 1. Choose Start > All Programs > FME > FME Administrator to display the FME Administrator dialog box. 2. To extend ProViewer, highlight it in the list and click Extend. The results display as in the next figure.



User Guide
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What’s New in MapInfo ProViewer 9.0?



3. Click Close to close the FME Administrator.



A Note about Displaying ESRI Data Source Datasets To display ArcSDE and Personal Geodatabase dataset layers, MapInfo ProViewer must have access to an ArcGIS desktop application such as ArcView®, ArcEditor®, ArcInfo® version 8 or greater or the ArcGIS engine and specifically the following client dynamically linked libraries (DLLs): •



sde.dll



•



sg.dll



•



pe.dll



These libraries are installed with the ArcGIS 9.2 desktop application, the ArcSDE SDK 9.2 or ArcReader 9.2 and they are present if you have installed ArcView® 9.2, ArcEditor® 9.2, or ArcInfo® 9.2. For more information about ArcGIS Desktop applications and the ArcSDE SDK, refer to the appropriate ESRI documentation. Note: You can download these DLLs for free from this web address: http://www.esri.com/software/arcgis/arcreader/ To help ProViewer find these DLLs, it is important to set the PATH environment variable in your system settings to reference the local folder that contains these DLLs. For example, if you have ArcGIS 9.2 Desktop installed to: C:\Program Files\ArcGIS then the following directory should contain the ArcSDE 9.2 client libraries, and this directory needs to be added to your PATH: C:\Program Files\ArcGIS\ArcSDE\bin. Similarly, if the ArcSDE SDK 9.2 is installed to the default location, then the required ArcSDE 9.2 client libraries should be in the following directory, which needs to be added to your PATH: C:\ArcGis\ArcSDE\bin. If you do not adhere to this path configuration, the ArcSDE and Personal Geodatabase layer data cannot display.
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MapInfo ProViewer 9.0



Chapter 1: Introduction to MapInfo ProViewer



Time and Date Time Data may Display in Version 9.0 Maps If your organization maintains time- or date and time-specific data, your map creators may use a new time and date time functionality to display this information in your thematic maps. Using this new feature your new maps can display time-sensitive data thematically. These maps are useful for many types of projects, such as to display crime information based on date and time or to post schedules based on resource availability on a particular date. You cannot change this data in any way, but you can see the effects of this new functionality in your MapInfo 9.0 maps. Maps created in previous versions of MapInfo Professional can be updated to display this information, but ProViewer does not display this information automatically.



Using the Find Command in Remote Tables The Find command (Select > Find) is available for linked remote tables, regardless of whether they are indexed. Neither the table nor a column in the table needs to be indexed for the Find command to be available.



If the selected column in the search table does not have an index, an index will be created when you click OK in the Find dialog box. For native tables and linked remote tables, this newly created index is permanent.



Multiple HotLink Capability Added We added the ability to access more than one HotLink definition per map object. When you click a map object with multiple HotLinks, a list of options are displayed, which allows you to access different types of content for a single map object. For example: • • • • •



Your Web site Product or Service Documents Applications Flash Demonstrations Anything you can open with a mouse click or double-click



For example, if your map creator added HotLink access to your web site, product information, and a tutorial, you could click the map object and display a list of options as in the next figure. User Guide
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What’s New in MapInfo ProViewer 9.0?



Homeland Security Fonts Added Your map creators now have access to new standard fonts prepared by the Office of Homeland Security. These fonts were developed to standardize the way emergency circumstances and industries are depicted in maps. Specifically the new symbols are: • • • •



Incidents - These fonts show various hazardous circumstances such as fires, police activity, and other dangers. Infrastructures Stage 01 - 04 - These fonts show various industrial environments including farms, factories, financial businesses etc. in a wide variety of complex frames to indicate severity Natural Events - These fonts show areas of natural disasters such as hurricanes, tsunamis, volcanoes and other natural events Operations Stage 01 - 04 - These fonts show various emergency circumstance symbols such as ambulances, biohazard, and Red Cross-type symbols in a wide variety of complex frames to indicate severity



New Projections and Coordinate System Supported Added Bosnia-Herzegovina Coordinate Systems. We have added the following projections: •



Bosnia-Herzegovina (Zone 5)



•



Bosnia-Herzegovina (Zone 6)



•



Bosnia-Herzegovina (Zone 7)



Added Luxembourg Projections. We have added the Luxembourg 1930 / Gauss\p2169 Luxembourg projection. Added S-JTSK (KROVAK) Coordinate System. We have added a new S-JTSK projection to serve the Czech Republic and Slovakia. We have added using new Projection #32 and new Datum #1020. Added Swedish Coordinate System. We have added the ST 74 projection.
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MapInfo ProViewer 9.0



Chapter 1: Introduction to MapInfo ProViewer Updated EPSG Aliases for Swedish Coordinate Systems. We have added two new EPSG aliases for Swedish coordinate systems to the PRJ file to maintain consistency with the latest update to MapXtreme: •



EPSG:2326



•



EPSG:3152



Updated Hong Kong EPSG Code. We have added the Hong Kong 1980 Grid System\p2326 EPSG code entry. Updated Australian Victorian Coordinate System. We have added the following Australian bounded projections: •



VIC VicGrid66 (AGD 66)



•



VIC VicGrid94 (GDA 94)



•



VIC AMG Zone 54 (AGD 66)



•



VIC AMG Zone 55 (AGD 66)



•



VIC MGA Zone 54 (GDA 94)



•



VIC MGA Zone 55 (GDA 94)



•



VIC Longitude/Latitude (AGD 66)



•



VIC Longitude/Latitude (GDA 94)



Updated Danish Coordinate System Entries. We have added the following Danish projections: •



UTM Zone 32 Euref89\p25832



•



UTM Zone 33 Euref89\p25833



•



UTM Zone 32 (ED 50)\p23032



•



UTM Zone 33 (ED 50)\p23033



•



System 34 Jylland-Fyn\p34003



•



System 34 Sjaelland\p34005



•



System 45 Bornholm\p45001



•



KP2000 Jylland-Fyn\p18401



•



KP2000 Sjaelland\p18402



•



KP2000 Bornholm\p18403



Features Added in Previous Versions of ProViewer This section provides a history of the previous changes to the ProViewer product.



New in ProViewer 8.5 More Room on the Status Bar. We have enlarged the Status Bar cursor location and file name fields to ensure that this information is more readable. We have also simplified the coordinate entry to display in decimal degrees.



User Guide
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Features Added in Previous Versions of ProViewer Printing Large Images Improved. Customers printing large images (such as destination page size D, E, or A0) previously reported problems using MapInfo ProViewer. Some of the printing problems stemmed from a 28,000 pixel limitation that we have addressed in this version of MapInfo Professional. MapInfo no longer supports the Windows 95 or 98 operating systems, which allowed us to remove this restriction. Better Support for GRD Files. MapInfo Professional 8.5 added a new preference that allows you to display Vertical Mapper GRD maps as grid files and not as raster files. Vertical Mapper creates GRD\TAB files that display using the raster handler. The new preference contains a Grid option, so you can view Info tool information about 3D GRD maps. Raster Image Reprojection Enhanced. In MapInfo Professional, we added automatic image reprojection for registered raster data such as satellite and aerial photo images, scanned maps, grids, seamless tables and WMS data. Previously, map professionals were restricted to reprojecting the vector maps. You are now able to view maps created using this feature. AirPhoto Raster Handler Upgraded. We have incorporated the latest AirPhoto Raster Handler 4.23 into the 8.5 release of MapInfo Professional. You are now able to review map files created with this new AirPhoto format. Coordinate System Enhancements. The following are the coordinate system enhancements for this version: •



•



•



• •



ETRS-based Coordinate Systems Added. We have added the following ETRS-based projections to our PRJ file: Transverse Mercator Zone 26-39, Lambert Conformal Conic, and Azimuthal Equal Area. Lithuanian and Latvian Coordinate Systems Added. We have added the following Latvian Coordinate Systems to the PRJ file: LKS-92, and Longitude/Latitude (LKS-92). We have added EPSG codes to the following Lithuanian Coordinate Systems: LKS-94, Baltija-92, Longitude / Latitude (LKS-94) and KS-1942 Zone 4. Estonian Coordinate System Added. We have added the following Estonian Coordinate System L-EST 97. Swedish Coordinate System Added. We have added Swedish Coordinate Systems for Aviation maps. South African Coordinate System Zones Added. We have added several Gauss Kruger Coordinate System zones.



New Help System Enhancements. We have updated the MapInfo Professional Help System to provide new functionality that you may already be using in other Microsoft products. •



• •
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Reading help topics gets easier. When you click in a help topic you can use the mouse wheel to scroll up and down through the topic as you read. This is the quick way to get through help topics and move on to getting your work done. Type too small? Zoom in! If you press and hold the Ctrl key while you use the mouse button to scroll through a topic, the type displays in a larger font so you can read the text clearly. Access to the most current MapInfo Professional documentation is easier! At the bottom of each help topic, there is a web address that takes you to the MapInfo web page. From there you can get the latest MapInfo Professional documentation or peruse documentation for other MapInfo products. You must be connected to the Internet for this feature to work.



MapInfo ProViewer 9.0



Chapter 1: Introduction to MapInfo ProViewer •



Can’t find a favorite topic? Save it in the Favorites tab! You can store topics you refer to all the time on a Favorites tab, which persists from session to session.



To save a favorite topic in the Favorites tab: 1. Open the Help System by doing one of the following: •



Click Help in a dialog box



•



Select Help > MapInfo Professional Help Topics



2. Click the Search tab and display the topic you want to save. 3. Click the Favorites tab and click Add. The Help System adds the topic to the list.



New in ProViewer 8.0 Autoscroll now more consistent. The T key is now used to toggle Autoscroll on and off. It used to be that A turned Autoscroll on and T turned Autoscroll off. More Nodes. Increased the number of nodes permitted per object for regions, polylines, and multipoints. Added support for the ASRP version 1.2 raster format. Added New Datums, Projections and Ellipsoids including: • • • • • • •



Chinese Coordinate Systems Guernsey Grid Coordinate System Hellenic Geodetic Reference System Baltic Projections (Lithuanian and Latvian) New Zealand Geodetic Datum 2000 New Belgian Coordinate System Additional British National Grid Coordinate System



New Grid Handler. Added the Arc Grid Handler to support the use and display of ESRI grid files.



New in ProViewer 7.8 Improved File Handling. Open MapInfo Professional 7.8 workspaces and table files. This includes .tab files referencing ESRI Shapefiles and table files containing new projections. WFS and WMS Support. View workspaces and .tab files that reference Web Map Service (WMS) and Web Feature Service (WFS) layers. Large Crosshair Selection. Support for selecting nodes more precisely. Supports Larger Excel Files. Open .tab files that reference larger Excel files (more than 32K rows). Enhanced Centroid Snap Capabilities. Enhanced 3DMap Viewing. Improved PrismMap lighting. Removed 255K character limit in Layout and Map windows in workspaces. User Guide
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Displaying a Map in MapInfo ProViewer Upgraded raster handlers. Upgraded the LeadTools to version 13, MrSID SDK (3.2) to provide support for MG3 files and updated the current raster handlers to handle multi-threading; specifically for ECW and the Government handlers (ADRG, ASRP, CADRG, CIB, NITF).



New in ProViewer 7.0 Microsoft Windows-like File Open Dialog Box Support Added. You can now use My Documents, Desktop etc. button options that have been added to the File Open Dialog Box. ESRI Shapefile Support Added. You can now open .tab files that reference ESRI Shapefiles. Raster Format Support Added. You can now open .tab files that reference ECW, MrSid, JPEG 2000, ADRG, CADRG, CIB and NTIF raster format files.



Displaying a Map in MapInfo ProViewer To explore the basics of desktop mapping concepts, let’s explore the World.wor workspace, which is installed with ProViewer. To display a map in the ProViewer product: 1. Click the Start button, select the All Programs, MapInfo and MapInfo ProViewer to display the ProViewer window. 2. Click the button or from the File menu, select Open button to display the Open MapInfo Tables or Workspaces dialog box.



Note You cannot open .MWS files created with MapInfo Professional in ProViewer. 3. Click the Data directory and click Open.
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MapInfo ProViewer 9.0



Chapter 1: Introduction to MapInfo ProViewer 4. Click the World directory and click Open. 5. Select the World.wor entry and click Open to display the World workspace.



Understanding the ProViewer Toolbar The toolbar icons at the top of the MapInfo ProViewer window can help you perform mapping work easily and efficiently. The Help System contains a detailed explanation of each icon. Icon



User Guide



Name



Icon



Name



Icon



Name



Open



Print



Help



Select



Zoom In



Zoom Out



Change View



Grabber



Info Tool



Drag Map Window



Ruler



Show/Hide Legend



Label



HotLink



Show/Hide Statistics



Select Boundary



Marquee Select



Radius Select
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A Brief Tour of the World.wor Workspace Icon



Name Select Polygon



Icon



Name Graph Select



Icon



Name Unselect All



Invert Selection



A Brief Tour of the World.wor Workspace Use the World.wor to review the map layers and experiment with these icons to become familiar with their functionality. You can think of a workspace as a map with transparencies stacked on top of it. Each layer contains data that pertains to the entire map. For example, World.wor includes the Ocean, the Countries, and the World Capitals layers.



Using the Select Icon This is the Select tool’s default cursor. Position the cursor over any region to display the name of the region. There are several selection icons that allow you to select map features and group regions for display. See the Help System for more about the specific properties of each icon.
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MapInfo ProViewer 9.0



Chapter 1: Introduction to MapInfo ProViewer



Using the Statistics Icon Click the



Statistics icon to display more about a selected country in the Statistics window.



Using the Ruler Icon The Ruler tool can show distance between two points on a Map window. 1. Choose the Ruler button and position the cursor, which displays as a cross, anywhere on the map and click.



The Ruler window displays Distance and Total. As you move the cursor, the Distance measurement changes in the Ruler window.



User Guide



•



To measure the distance between two points, click the first point and double-click the second.



•



To measure the length of a path containing two or more segments, continue the process, clicking once at the end of each segment to keep a running total of the length of the path.
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A Brief Tour of the World.wor Workspace



Using the Zoom Icons The Zoom options give you control over the display of the Map window. 1. Open a Map window and click the map.



Zoom in button. Position the cursor anywhere on the



Full featured MapInfo products allow you to determine the range (for example 0 to 3 miles, 2 to 5 miles) at which each layer is visible in a Map window. 2. To see the effect of zooming click the Zoom in icon anywhere on the map. The map redraws at the new zoom level. Notice that the information changes in the Zoom section of the Status Bar to reflect a new zoom level.



3. To specify the zoom level of the map, click the level.



Change View button and enter a new zoom



At different zoom levels, new information displays on the map reflecting the visibility of the different map layers that comprise World.wor.
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MapInfo ProViewer 9.0



Chapter 1: Introduction to MapInfo ProViewer



Displaying the Map Legend The map’s legend explains the meaning of the different shapes, colors, and fill patterns. 1. Open a Map window and click the Show/Hide Legend command.



Legend button or select the Options menu and the



Note Not all maps have legends. 2. Choose the Map menu option and the Previous View command to return the map from the beginning. We have provided the icon descriptions, the Glossary, and the online help to support you as you navigate through more mapping adventures!



Getting Online Help Use ProViewer‘s comprehensive online Help, including sections on menu commands and dialog box descriptions, to answer your ProViewer questions.



Getting Technical Support If you encounter problems installing MapInfo ProViewer, our technical support specialists can help. Technical Support for MapInfo ProViewer is limited to installation issues. For workspace-related issues, see the MapInfo Professional user who created the workspace.



User Guide
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Want to do MORE? For questions concerning the installation of ProViewer, contact MapInfo Technical Support at 518/ 285-7283 or visit the MapInfo web site (http://www.mapinfo.com).



Want to do MORE? Consider... MapInfo Professional, the premier desktop mapping product for business and government. MapInfo Professional allows users to access their own data to see relationships between data and geography, answering questions such as... • • •



Where are my best customers located? Where should I place my next sales office? How can I increase my sales?



MapInfo Professional answers these questions in a straightforward manner, reducing the time it takes to make smarter decisions.
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MapInfo ProViewer 9.0



Glossary



This section contains a list of terms we use to describe ProViewer features and capabilities.



A



Term



Definition



Browser



A window for viewing a table (or a database, a spreadsheet, or a text file) in tabular form.



Coordinate



An X,Y location in a Cartesian coordinate system or Longitude/Latitude location in an earth coordinate system. Coordinate systems represent locations on a map relative to other locations. Earth coordinate systems may use the Equator and the Greenwich Prime Meridian as fixed reference points. Plane coordinate systems describe a two-dimensional X,Y location in terms of distance from a fixed reference point and are usually in the first quadrant so that all coordinates are positive.



Degrees of Longitude, Degrees of Latitude, and Decimal Degrees



Degrees (longitude and latitude) are coordinates used to represent locations on the surface of the Earth. Longitude (or X coordinate) represents a location’s east-west position, where any location west of the Prime Meridian has a negative X value. Latitude (or Y coordinate), represents a location’s north-south position, where any location south of the Equator has a negative Y value.



Field



A field in a table corresponds to a column in a Browser. A field contains a specific type of information about an object, such as: • • • • •



Name Abbreviation Land Area Price Population etc.



The record for each object consists of the object’s values for each of the fields in the database.
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Graticule



A grid of horizontal (latitude) and vertical (longitude) lines that display on an Earth map spaced at a regular distance (for example, every five degrees, every fifteen degrees). Used to establish a frame of reference.



Latitude



The horizontal lines on a map that increase from 0 degrees at the Equator to 90 degrees at both North (+90.0 degrees) and South (-90.0 degrees) Poles. Used to describe the north-south position of a point as measured usually in degrees/minutes/seconds or decimal degrees above or below the Equator.



Legend



The part of a map that explains the meanings of different colors, shapes, or fill patterns used on a map. A legend can also include a scale.



MapInfo ProViewer 9.0



Appendix A: Glossary Term



Definition



Longitude



The vertical lines on a map that run from the North to the South Poles, used to describe the east-west position of a point. The position is reported as the number of degrees East (0 to -180.0 degrees) or West (0 to +180.0 degrees) of the Prime Meridian (0 degrees). Lines of Longitude are farthest apart at the Equator and intersect at both Poles, and therefore are not parallel.



Map Scale



A statement of a measure of the map and the equivalent measure on the earth. Often expressed as a representative ratio of distance, such as 1:10,000. This means that one unit of distance on the map (for example, 1 inch) represents 10,000 of the same units of distance on the earth.



Map Window



A window that allows you to view a table as a map.



Node



An endpoint of a line object, or an endpoint of a line segment which is part of a polyline or region object.



Raster



A type of computerized picture consisting of row after row of tiny dots (pixels). Raster images are sometimes known as bitmaps. Aerial photographs and satellite imagery are common types of raster data found in GIS. A computer image can be represented in raster format or in vector format.



Record



All the information about one object in a database or a table. A record in a table corresponds to a row in a Browser.



Selection



A data item or set of data items chosen for inspection and/or analysis. In Browsers, and in Map windows, items can be placed in the selection set by clicking on them individually. Map windows also have special tools for selecting multiple items on a spatial basis.



Status Bar



A bar at the bottom of the screen that displays messages that help in using MapInfo ProViewer.



Table



MapInfo information databases are organized as tables. Tables are made up of rows and columns. Each row contains information about a particular geographic feature, event, etc. Each column contains a particular kind of information about the items in the table. MapInfo tables can contain graphic objects representing geographic objects. Such tables can display as maps.



Toolbars



MapInfo windows that contain a variety of buttons used to access tools and commands for mapping and drawing.



Vector



A coordinate-based data structure commonly used to represent map features. Each object is represented as a list of sequential x,y coordinates. Attributes may be associated with the objects. A computer image can be represented in vector format or in raster format.



User Guide
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Term



22



Definition



Workspace



A saved configuration of open MapInfo tables and windows.



Zoom Layering



A setting that determines the range (for example, 0 - 3 miles, 2 - 5 miles, etc.) at which a layer is visible in a Map window.
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Index Numerics



HotLink, using multiple in version 9.0 7



3D Viewing, enhanced in version 7.8 11



L



A



Labels, curved 4 Legend, displaying a map’s 17



Autoscroll, changes in version 8.0 11



C Character Limit Removed, 255K _ in version 7.8 11 Coordinate Systems new in version 8.0 11 new in version 8.5 10 new in version 9.0 8 Crosshair, new support added in version 7.8 11 Curved Labels, understanding 4



D Data Sources a note about ESRI datasets 6 opening in version 9.0 5 Displaying a Map 12



E Excel Files, larger file support added in version 7.8 11



F File Handling, improved in version 7.8 11 File Open Dialog, new support added in version 7.0 12 Find command, using in version 9.0 7



G GRD Files, support changes in version 8.5 10



H Help changes in (version 8.5) 10 getting online 17 Homeland Security Fonts, in version 9.0 8 Guide Title



M Map, displaying in ProViewer 12 MapInfo Professional, getting more out of maps with 18



N Node Support, changes in version 8.0 11



P Printing, changes in version 8.5 10 Projections new in version 8.0 11 new in version 9.0 8 ProViewer displaying a map in 12 features added in 7.0 12 features added in 7.8 11 features added in 8.0 11 features added in 8.5 9 features added in 9.0 4 installing 4 understanding the toolbar 13



R Raster Images AirPhoto handler upgraded in version 8.5 10 ASRP support added in version 8.0 11 handlers upgraded in version 7.8 12 reprojection changes in version 8.5 10 support for new formats added in version 7.0 12 Ruler icon 15
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Index



S Select icon 14 Shapefiles, support for ESRI _ added in version 7.0 12 Snap Command, centroid _ enhanced in version 7.8 11 Statistics icon 15 Status Bar, changes in version 8.5 9



T Technical Support, getting 17 Time and Date Time Data, opening in version 9.0 7 Toolbar using the Ruler icon 15 using the Select icon 14 using the Statistics icon 15 using the Zoom icons 16 Toolbar, icons in 13



W WFS Support, added in version 7.8 11 WMS Support, added in version 7.8 11



Z Zoom icons 16



Guide Title
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MapInfo ProViewer 
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